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Communication Between a Sunny Boy 1800U or 2500U 
and a PC 

Overview 
This technical note details how to set up communication between a personal computer and a 
Sunny Boy 1800U or 2500U photovoltaic inverter.  This document does not attempt to describe 
communication software or functional operation of communication devices external to the Sunny 
Boy inverter. 

Safety Warning 
Sunny Boy inverters operate with potentially lethal voltage and current from multiple power 
sources.  Only qualified personnel should attempt to work on the inverter. 
The Sunny Boy inverter must be isolated and locked-out from all AC and DC power sources prior 
to installing the hardware necessary for R232 communication.  Allow five minutes for internal 
capacitors to discharge before removing the cover to the Sunny Boy and beginning work on the 
inverter. 

Application 
Communication between a SB1800U or SB2500U inverter and a PC may be accomplished using 
an RS232 direct wire connection.  The RS232 protocol limits communication between a PC and 
only one inverter.  The maximum wire run distance is 15 meters. 

 
Note:  The wiring diagram now includes information on connection to a Palm serial device.  For 
information on interfacing directly to a Sunny Boy inverter from a Palm device, please contact 
Sunny Buddy (contact information may be found in the appendix). 

Necessary Accessory Equipment 
The following accessory equipment is required: 

- RS232 communication board 
- RS232 wire harness 
- Personal computer with Windows 95 or later operating system 
- Sunny Data software program 
- Zip file decompression software (WinZip or equivalent) 
- German – English dictionary (optional, a small portion of the Sunny Data software text is 

still in German) 
These devices (excluding the PC) are available from SMA-America.  The wire harness is 
available in 5, 10 or 15 meters.  Call 530-273-4895 for information. 

SMA Communication Program Compatibility 
The software program Sunny Data is required to communicate directly to SMA Sunny Boy 
inverters.  It is available, free of charge on the SMA web page: www.sma.de.  Be sure to use the 
Sunny Data program and not the Sunny Data Control.  Sunny Data Control is designed to work 
with the Sunny Boy Control family of remote interface devices.  It will not work directly with the 
Sunny Boy inverters. 
The Sunny Data program requires: 

- IBM®-compatible computer with a minimum 486-33MHz processor 
- Microsoft Windows 95, 98, 2000, or NT® 
- 128MB of RAM, 480x680 VGA monitor 

http://www.sma.de
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- At least 4MB of hard disk space plus excess storage capacity for data recording, if 
desired. 

- A minimum of 4MB of RAM 
- One free communication port (COM1 … COM4) 
- Zip file decompression program (WinZip or equivelant) installed on the PC 

The Sunny Data software program is property of SMA Regelsysteme GmbH.  SMA does not 
warrant the operation of this software nor does it make any promises for future program 
developments or improvements. The company SMA in no case assumes any kind of liability for 
damages, including and without restriction for direct or indirect damages due to damages of 
hardware in use, personal damages, profits lost, interruptions of work, data losses, or any kind of 
financial losses resulting from the use or failure of use of this software.  Check the SMA website 
periodically for current updates. 

Data Acquisition 
The Sunny Boy inverters do not have the ability to store historical data.  The Sunny Data 
communication program incorporates the ability to store real-time inverter data on the local PC.  A 
comma delimited, ASCII text data file is created daily and stored on the PC hard drive.  The 
Sunny Data program will locate the date file in a sub-directory of the program file, typically: 
c:\Program Files\SMA\Sunny Data\Plant##\Data\########.SOU 
The file name is a 6 digit date code followed by a 2-digit index.  It may be imported and post-
processed by a program such as Microsoft Excel or Access.  This data is stored in a user-defined 
time interval.  It is not averaged over the time interval. It is a ‘snapshot’ of the inverter at the time 
the data is stored. 

Cabling Requirements 
If you choose to construct your own cable, we recommend using the following wire type: 

- #24 AWG, stranded copper conductors 
- Two twisted-pair (four wires) with overall shield (foil or braid), with drain wire 
- Low capacitance, less than 20pF 
- Outer insulation suitable for the specific application (outdoor, wire tray, UV resistant, wet 

weather, etc.) 
- The connector for the PC COM1 is typically a DB9-Female, some computers may require 

a DB25-Female.  The inverter side is open wire for connection to a screw type terminal 
strip on the inverter control board within the enclosure (shown in the following diagrams). 

Hardware Installation and Configuration 
The following inverter hardware changes must be made for RS232 communication to a SB1800U 
or SB2500U inverter: 

Inverter Preparation 
Disconnect the inverter from AC and DC power sources.  Wait 5 minutes before removing 
the cover to let the internal capacitors discharge. 

Resistor Removal 
Remove the cover of the Sunny Boy inverter. 
There are two resistors (light-blue or tan color) in the lower left region of the small control 
board in the center of the inverter enclosure (these are shown in the diagram at the end 
of this section).  They are part of the powerline communication circuitry which must be 
disabled for RS232 communication.  These need to be removed.  We recommend 
carefully cutting one side of each resistor and bending them up from the board.  This will 
simply reconnection if powerline communication is desired in the future. 
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Installing the RS232 Communication Board in a SB1800U or SB2500U 
To the left of the resistors are two, two-row headers (shown in the diagram in the next 
section).  Install the RS232 piggy-back onto these headers.  The long socket on the 
RS232 board mates with the upper set of header pins on the inverter control board.  The 
lower header row will have an extra set of pins to the right side that do not connect with 
the RS232 board. 

 

 
Jumper Configuration 
Below the powerline coupling resistors on the inverter control board are three dual rows 
of jumper pins.  Remove all jumpers from these pins.  We recommend leaving any 
existing jumpers hanging from just one pin on each row for future use. 

The following picture shows the interior of the SB1800/2500U inverter.  Note the location of the 
RS232 piggy-back board, the blue resistors and the terminal block for connecting the 
communication harness. 

RS 232 Piggyback Board 
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SB2500U Control Board 

Jumpers 

Powerline Resistors 
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RS 232 Installed in SB1800/2500U 
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Install the Communication Wire Harness 
Install the communication wire harness to the green terminal block on the lower left section of the 
inverter control board as shown below.  The following diagram shows the communication harness 
wire configuration and connection to the inverter: 
 

232PB-G3

1 2 3 4 5 6 7 8 910

2 RXD

3 TXD

5 GND
DB9-Female to PC 

Communication Port

Open Pins
Not Used

Light Blue or Tan Resistors
Removed (Cut and Lift)

RS232 Piggyback
Communication Board

Sunny Boy 1800/2500U Main Control Board

Jumper Pins
Not Mounted

Connect Shield to 
Inverter Chassis

S4

DB9-Male to
Palm Serial Serial Hot-Sync Cradle

(Note: pins 2 & 3 are
reversed from PC connector)

5 GND

3 TXD

2 RXD
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Sunny Data Program 
The following steps will walk you through configuring the PC to communicate with a Sunny Boy 
inverter.  This procedure is not intended to cover the complete operation of the Sunny Data 
program.  It is only provided to assist in initial communication between the Sunny Boy inverter 
and a PC.  For detailed information on the function of the Sunny Data software program, please 
refer to the Sunny Data Operation Manual. 

Install the Sunny Data Program 
- Install the Sunny Data, V1.70 program on the PC. The installation wizard will 

guide you through installation process. The original program supplied by SMA is 
Zip compressed.  You must have a Zip decompression program installed on the 
PC prior to installing Sunny Data. 

- Verify the communication cable is connected between the PC and Sunny Boy 
inverter (refer to diagram from previous section). 

- Verify the communication port is active on the PC.  This is typically found by: 
o Right clicking on the My Computer icon on the Desktop 
o Select Properties 
o Left click the Hardware tab 
o Left click Device Manager 
o Left click the + symbol to the left of ‘Ports (Com & LPT)’ 
o Right click on Communications Port (COM1).  If there is a red X over the 

plug icon, the device is disabled.  Right clicking on the device may 
provide the option to enable the port.  If the option is not available, the 
port may be disabled in the system BIOS.  This will require rebooting the 
computer and entering the BIOS to enable the COM1 port.  Consult the 
PC manual for changing BIOS settings. 

o Select Properties 
o In the Device Status window will state whether the device is working 

properly 

Run the Sunny Data program. 
- It may be found in the Start menu, Programs, Sunny Data, Sunny Data V1.70.  

Running the program for the first time will result in a blank program window with 
a row of pull down menus. 
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Configure the Communication Port 

- Select the Options pull-down menu and then Serial Port 

 
- Select COM1, RS232 and set the Baud Rate to 1200.  Some computers may be 

configured to use a different communication port. 
- Click OK 

Detecting Inverters 
- Select the Options pull-down menu and then Device Detect / Configure 
- The following window will appear after two seconds: 
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- Click Auto Install and the following warning message will appear: 

 
- Click OK.  A blue scrolling timer will appear.  After a second the window should 

show 1 device as found.  After the timer has finished scrolling, the device serial 
number will show in the Detected Device window and the following window will 
appear: 

 
- Click OK 
- Click Done 

If the program times out without detecting the inverter, verify the communication port is 
configured properly in software.  Also verify the communication wire harness is 
configured and connected properly. 
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Configure PV Plant Display 
- From the pull-down menu Display, select Scheme PV Plant 
- The following screen will appear. 

 
This artwork may be changed by selecting New Background from the Display pull-down 
menu. 

- Right click in the display window and select Insert New Display.  The following 
window will appear: 
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Device WR25U02E-1 is an example of the Sunny Boy 2500U inverter.  Device 
WR18U04E is an example of a Sunny Boy 1800U inverter.  Select the channels you want 
to display from the Channel menu.  Select multiple channels by clicking them with the 
shift or ctrl keys held down.  When finished click OK.  These channels will appear in the 
display screen. 
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Arrange the channels by dragging them where desired or right click the display screen 
and select Arrange All At Grid, or Arrange All Displays Automatically. 

 
The Sunny Data program is now communicating with the Sunny Boy inverter in real time.  
Each parameter will update every 5 seconds.  For information on configuring the Sunny 
Data program to store real-time data values to the computer hard drive, refer to the 
Sunny Data Operations manual. 

Closing the Sunny Data Program 
- From the File pull-down menu select Exit.  The following message will appear 

since changes have been made to the PV Plant display: 

 
- Select Yes to save the desktop configuration.  The next time the program is 

started, it will automatically begin communicating with the inverter configured in 
this example. 
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Sunny Data Software Manual and Updates 
Please refer to the Sunny Data Operations manual for further information on the functions 
and operation of the Sunny Data program.  Current versions of this manual may be 
downloaded from the SMA website: www.sma-america.com /documentation. 
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Contact Information 
 
SMA America:  
12438-C Loma Rica Drive 
Grass Valley, CA 95945 
530.273.4895 
www.sma-america.com 

 
Sunny Buddy:  
John Powers 
sunny@poohbah.com 
www.poohbah.com 
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